File Menu

Item

New

Open...
Quick Open

Import Multiple

Files...
Close
Save
Save As...
Revert

Save Project

Save Project As...

Export...

Publish

Database

Internet Open

SAS

Preferences

Print...

Print Preview

JMP 17 Windows Menu Descriptions

Description

Creates a new data table, script, journal, database query, project, application, dashboard, add-in,
or workflow.

Locates and opens files of different types.
Enables you to enter a search term and find recently opened files from any JMP window.

Opens multiple files from a folder, combining similar files into data tables.

Closes the active window. Prompts you to save changes.

Writes the active window to a file, providing a choice of appropriate extensions.

Writes the active window to a file after prompting you for a file name and type.

Restores the current JMP file to its last saved condition.

Saves the current project. Available only when a project is unsaved.

Saves the current project using the specified name. Available only when a project is open.

Exports data to text, [SON data, Microsoft Excel, an image, PDF, HTML, Interactive HTML with
Data, RTF, Microsoft PowerPoint, or Microsoft Word. The available options are based on the type
of file that you are exporting.

Publishes the current reports to a web page. You can publish to JMP Live, JMP Public, or to an
interactive HTML web report. You can also publish data to JMP Live. Use the Manage
Connections option to add new JMP Live connections.

Opens the Query Builder for interactively building SQL queries; opens a connection to any
database on your system that has an ODBC driver; opens or saves a data table; or imports a
database from an OSlsoft PI Server.

Opens remote files in a browser or text editor window, and opens an HTML table as a data table.
Enables you to open JMP data tables and run scripts from a URL. Also provides a way to open
data as a Google Sheets spreadsheet.

Connects to a SAS server; opens the SAS Query Builder for interactively building SQL queries;
enables you to browse and run SAS® Stored Processes or open SAS data files and folders;
provides an editor window; sends SAS code from JMP to the currently active SAS server; opens
SAS Log and Output windows; and exports data to SAS.

Enables you to edit settings for start-up items, reports, tables, analysis platforms, import and
export settings, graphic formats, fonts, SAS integration, and more. In addition, you can search for
specific preferences and filter the results based on the version of JMP. Also enables you to reset
defaults.

Prints the active window.

Displays the contents of the active window in print view.



File Menu (Continued)

ltem
Page Setup...
Recent Files

Save Session
Script...

Exit ]MP

Edit Menu

Item
Undo
Redo

Cut

Copy

Copy As Text

Copy With Full
Precision

Copy With Column
Names

Paste

Paste With Column
Names

Clear

Select All

Save Selection As...

Encrypt Script...

Decrypt Script...

Description
Displays the standard window for setting printed page properties.
Displays a list of the most recently opened files for easy re-opening.

Creates a JMP Scripting Language (JSL) script to re-open all currently open files and re-run all
currently open analyses and graphs.

Closes all JMP windows and quits JMP. Prompts you to save new or changed JMP files. Also asks
whether you want to save the session script.

Description
Cancels the effect of the most recent reversible Edit, Rows, or Columns command.
Reverses the most recent Undo command.

Copies selected data table cells to the clipboard and replaces the data with missing values. In
reports and other windows, copies selected content to the clipboard.

Copies selected data table cells to the clipboard. In reports and other windows, copies selected
content to the clipboard.

Copies all text (but no graphs), or text selected using the selection tool, from the active report
window to the clipboard.

Copies a column of numeric data and maintain the full precision. Applies only to the fixed
decimal format.

Copies selected data table cells and column names to the clipboard.

Copies content from the clipboard into the open window.

Copies data from the clipboard into the active data table. Converts text on the first line of the
clipboard to column names.

Removes selected data table cell contents and adds missing values. In journal and script windows,
removes selected content.

Selects all rows in a data table. In reports and other windows, selects all content when one item is
selected.

Saves selected portions of an analysis window in a graphic format.

Places encoding in a script so that you must have the password to open or run the script. Available
only if an unencrypted script is in the active window. When an encrypted script is in the active
window, the menu item changes to Decrypt Script.

Enables you to open or run an encrypted script. Available only if an encrypted script is in the
active window.



Edit Menu (Continued)

Item

Import as Data

Run Script

Debug Script
Stop Script
Submit to SAS
Search

Go to Line...

Balance

Comment Block
Uncomment Block
Reformat Script

Journal

Lock Journal

Properties

Tables Menu

Item

Summary

Subset

Sort

Stack

Split

Transpose

Description

Imports text-formatted data using the Import Settings in File > Preferences > Text Data Files.
Before selecting the Import as Data command, you must paste the data into the active script
window.

Processes JSL commands entered in the script window. You are prompted to select a data table, if
none are opened. If several data tables are opened, the script is run on the last table that you
opened. Otherwise, the script is run on the only open data table.

Enables you to troubleshoot script errors in the JSL Debugger.

Stops running a JSL script.

Connects to a specified SAS server and submits SAS code directly from JMP.
Finds and replaces text in data tables and scripts.

Scrolls to a specific line number in a script.

Selects all text within a pair of brackets that include the cursor. Available only if a script window is
active.

Comments the selected block in the JSL script.
Uncomments the selected commented block in the JSL script.
Adds tab and return characters where appropriate to display the script in more readable layout.

Copies output from a data table or report window to a journal window. Enables you to save
reports, add notes, and organize output.

Prevents you from editing the journal.

Enables you to modify the formatting of display boxes in a report.

Description

Creates a table that contains user-specified summary statistics calculated from the active data
table.

Creates a new data table that is a subset of the active data table and can be linked to the original
data table.

Sorts a JMP data table by one or more columns. This creates a new data table, or you can replace
the original table with the sorted table.

Stacks selected columns into one or more new columns in a new data table.

Splits one or more columns, according to values in a Split By column, to form multiple columns in
a new data table.

Creates a new data table in which the data in the selected columns of the original table are
arranged in rows. Transposing equates to switching the rows and columns in the original
selection.



Tables Menu (Continued)

Item

Join

Update
Concatenate
JMP Query Builder

Missing Data
Pattern

Compare Data
Tables

Anonymize

Rows Menu

Item

Hide and Exclude
Exclude/Unexclude
Hide/Unhide
Label/Unlabel
Colors

Markers

Next Selected
Previous Selected
Row Selection
Clear Row States

Clear Selected Row
States

Color or Mark by
Column...

Row Editor

Delete Rows

Add Rows...

Description

Adds columns from a second table to the main table, using row number or matching columns, or
by forming a Cartesian join.

Replaces data in the active table with data from a second table without producing a new table.
Stacks two or more tables on top of each other by matching column names.
Interactively queries one or more data tables to create a new data table.

Describes the missing data in your table in terms of the columns where it is missing.

Compares the numbers of columns and rows, table properties and scripts, column attributes and
properties, and data in two open data tables.

Removes unique identifiers from the data table or selected columns.

Description

Hides and excludes selected rows in plots and analyses.

Excludes or includes selected rows in analyses.

Hides or shows selected points in all plots.

Labels or unlabels selected points in all plots.

Changes selected points in all plots to a specified color.

Replaces selected points in all plots with symbols that you select.

Locates and flashes the first selected row in a data table after the current row.
Locates and flashes the first selected row in a data table before the current row.
Provides several options for selecting rows based on one or more conditions.
Clears all active row states in the data table.

Clears all selected row states in the data table.

Assigns colors or markers to rows based on values in a selected column.

Opens a window that enables you to edit cells in a row. Helps you select rows and create new
rows.

Removes all selected rows from the data table.

Adds rows to a specified location in the data table.



Rows Menu (Continued)

Item
Move Rows...

Data Filter

Cols Menu

Item
New Columns...

Column Selection

Reorder Columns

Column Info...

Standardize

Attributes...

Preselect Role

Formula...

Label/Unlabel

Scroll Lock/Unlock

Hide/Unhide

Exclude/Unexclude
Use for Marker
Recode...

Columns Viewer

Utilities

Description
Moves selected rows to a specified location in the data table.

Selects, shows, or includes rows based on conditions on the values of selected columns.

Description
Adds a new column, and enables you to name the column and change attributes and properties.

Highlights and scrolls to the selected column. Locates and flashes the first or next selected column
in a data table after the current column. Selects any column that is currently deselected and
deselects any column that is currently selected.

Moves the selected column to the specified location. Rearranges columns by the original order,
name, data type, modeling type, or in reverse order.

Shows the column properties and enables you to change the column name, attributes, and
properties for selected column or columns.

Sets attributes and properties for multiple columns at once.

Assigns an analysis role, which can be saved with the data table, to selected column or columns.
Shows the formula editor window for selected column or columns.

Tells JMP whether to use values from the selected column or columns to identify points in plots
when the cursor is placed near them. To display labels for points on plots, the corresponding rows
must have a label row state.

Locks or unlocks selected columns into or from the left-most position in the table. Locking a
column keeps its contents visible when you scroll horizontally.

Hides or shows selected columns without removing them from the table. Retains them in
analyses.

Excludes or includes selected columns in analyses.
Displays the images in expression columns as markers on graphs.
Enables you to edit and group cell values for the selected column.

Provides a quick way to view columns using specific criteria (such as column names, properties,
and attributes). You can then view summary statistics and properties for those columns, view
quartiles in the summary statistics, show the columns in a separate data table, and more.

Restructures data. Compresses columns, converts a column of delimited data to multiple
columns, creates indicator columns, combines columns, customizes binned data, converts a
numeric column of codes to value labels, converts a column of strings to numeric codes, and
recodes column names. New Column by Text Matching uses a regular expression to parse a
column of text.



Cols Menu (Continued)

Item

Column Names

Clear Cell Colors

Group Columns

Ungroup Columns

Delete Columns

DOE Menu

Item
Custom Design

Augment Design

Easy DOE

Definitive
Screening

Classical

Description

Move Up moves the first row of data to the column heading row. Move Up and Append appends
the first row of data to the column names. Move Down moves the column headings to the first
row of data. Recode Names opens a recode window that provides recode options for column
names.

Clears the color of selected colored data table cells.

Groups columns under one heading to manage large numbers of columns and facilitate analysis
role assignment. Grouped columns are shown in outline view under a gray disclosure icon in the
columns panel.

Removes the grouping heading and displays individual column names in column panel and
analyses.

Removes selected columns from the data table.

Description
Creates D-optimal and I-optimal designs for a wide range of design situations and constraints.

Adds runs to an existing design in an optimal fashion. Provides different choices for how to add
these runs.

Provides a platform for designing, running, saving, analyzing, predicting, and documenting the
results of a designed experiment.

* Definitive Screening Design creates a design with three levels for every quantitative factor.
Main effects are independent of two-factor interactions, and two-factor interactions are not
confounded with each other.

¢ Fit Definitive Screening provides options for modeling definitive screening designs.
* Screening Design constructs classical and main effects screening designs. The factors can be

2-level continuous, discrete numeric, and categorical factors with an arbitrary number of
levels.

¢ Fit Two Level Screening provides options for modeling screening designs.

* Response Surface Design generates a list of classical response surface designs for the specified
number of continuous factors and creates the chosen design.

¢ Full Factorial Design creates a design using all combinations of factor levels for a set of
continuous and categorical factors with an arbitrary number of levels.

* Mixture Design creates a design that is appropriate when the factors are components in a
mixture. Some design types accommodate linear constraints.

* Taguchi Arrays constructs a Taguchi design. Signal and noise factors, a choice of inner and
outer array designs, and signal-to-noise ratios are supported.



DOE Menu (Continued)

Item

Design Diagnostics

Consumer Studies

Special Purpose

Sample Size
Explorers

Analyze Menu

Item

Distribution

FitY by X

Description

Evaluate Designs evaluates designs for any table treated as a design. You can modify the
model terms and the aliasing terms, and the diagnostics update accordingly.

Compare Designs compares two or three designs simultaneously to explore and evaluate their
performance. Provides diagnostics that show how the designs perform relative to each other
as well as how they perform in an absolute sense.

Sample Size and Power computes power, sample size, and effect size for means, variance,
proportions, and counts. The platform also computes sigma quality level and more.

Choice Design creates an optimal discrete choice conjoint experimental design. These designs
are useful in studies where users are asked to specify preferences relative to combinations of
product or service features.

MaxDiff Design constructs a design consisting of choice sets that can be presented to
respondents as part of a study where respondents specify most and least preferred
combinations of features.

Covering Array creates a design for testing systems where failures occur as a result of
interactions among components or subsystems (JMP Pro).

Space Filling Design creates a design that is appropriate when modeling deterministic or
nearly deterministic systems, such as computer simulations.

Accelerated Life Test Design constructs tests based on one or two accelerating factors with
either a main effects model or an interaction model for the latter.

Nonlinear Design creates an optimal design for estimating the parameters of a nonlinear
model.

Balanced Incomplete Block Design creates a design for testing a treatments in b blocks where
only k treatments (k < a) can be run in any one block.

MSA Design generates a full factorial design for a measurement systems analysis (MSA)
experiment and provides design diagnostic measures.

Group Orthogonal Supersaturated Design creates a supersaturated design where the factors
are partitioned into k orthogonal groups, with k =2 or a multiple of 4.

Fit Group Orthogonal Supersaturated provides options for modeling a group orthogonal
supersaturated design.

Enables you to investigate the impact of sample size on your ability to answer specific questions
when planning experiments or studies.

Description

Provides a histogram for continuous data and a bar chart for nominal or ordinal data, along with
relevant summary statistics. Presents options for many one-sample analyses, based on modeling

type.

Shows plots that describe the relationship between any two variables. Provides two-sample
analyses based on the modeling types of the two variables, such as bivariate, one way, logistic, and
contingency analysis.



Analyze Menu (Continued)

Item
Tabulate

Text Explorer

Fit Model

Predictive
Modeling

Specialized
Modeling

Screening

Multivariate
Methods

Clustering

Quality and Process

Description
Constructs tables of descriptive statistics using an interactive interface.

Analyzes pieces of unstructured text, such as comment fields in surveys or incident reports,
enabling you to interact with the text data with tools to consolidate similar terms, recode
misspecified terms, and gain understanding of the underlying patterns in your textual data.
(Analytics are available in JMP Pro.)

Fits models involving one or more Y variables and multiple X variables. Techniques include
standard least squares, stepwise, generalized regression (JMP Pro), mixed models (JMP Pro),
generalized linear mixed models (JMP Pro), MANOVA, loglinear variance, logistic, proportional
hazards, parametric survival, generalized linear models, partial least squares (JMP Pro), and
response screening.

Offers predictive modeling techniques: neural, partition analysis, bootstrap forest (JMP Pro),
boosted tree (JMP Pro), K nearest neighbors (JMP Pro), naive Bayes (JMP Pro), support vector
machines (JMP Pro), model screening (JMP Pro), and model comparison (JMP Pro). The menu
also provides options to make validation columns and access prediction models that you saved in
the Formula Depot (JMP Pro).

Offers specialized modeling techniques: nonlinear, functional data exploration, Gaussian process,
time series, time series forecast, and matched pairs.

Offers techniques for screening large data sets, including analyzing outliers and missing values.

¢ Explore Outliers enables you to explore outliers in both the univariate and multivariate cases.
* Explore Missing Values enables you to explore and impute missing values in your data.
e Explore Patterns enables you to explore and find unusual features or patterns in your data.

* Response Screening automates the process of conducting tests across a large number of
responses.

* Predictor Screening is useful in screening a data set for significant predictors.

* Association Analysis analyzes transaction (market basket) data to identify items that appear
together in transactions (JMP Pro).

* Process History Explorer analyzes complex processes to identify where a defect has occurred.

Offers techniques for exploring relationships among multiple variables: multivariate fitting,
principal components, discriminant analysis, partial least squares, multiple correspondence
analysis, structural equation models (JMP Pro), factor analysis, multidimensional scaling,
multivariate embedding, and item analysis.

Offers techniques for clustering: hierarchical clustering, K means clustering, normal mixture
clustering, clustering rows based on categorical variables using multinomial mixtures (latent class
analysis), and clustering variables into groups of highly correlated variables.

Offers techniques for evaluating quality-related issues in processes or products: control charts
(including an interactive control chart builder), CUSUM control charts, EWMA control charts,
model-driven multivariate control charts, legacy control charts, process screening, process
capability analysis (including capability for non-normal process measurements), measurement
systems analysis, variability and attribute gauge charts, Pareto plots, and fishbone (Ishikawa
Cause and Effect) diagrams. Other options include managing specification limits and creating a
graph of Operating Characteristic Curves (OC Curves).



Analyze Menu

Item

Reliability and
Survival

Consumer Research

Genetics

Graph Menu

Item

Graph Builder

Bubble Plot

Scatterplot Matrix

Parallel Plot

Cell Plot

Scatterplot 3D

Contour Plot

Ternary Plot

(Continued)

Description

Offers techniques for fitting survival and reliability data: life distribution, fit life by x, cumulative
damage, recurrence analysis, degradation, repeated measures degradation, destructive
degradation, reliability growth and forecasting, reliability block diagrams (JMP Pro), repairable
systems simulation (JMP Pro), product-limit survival fit, parametric survival distributions, and
proportional hazards modeling.

Offers techniques for studying consumer preferences. Options include categorical response
survey analysis, choice models, MaxDiff analysis, uplift models for identifying the positive effects
of marketing actions (JMP Pro), and multiple factor analysis.

* Marker Statistics platform provides a convenient method for exploring several properties of
all the biallelic markers in a data set, for the purpose of quality control (QC) and possibly
selecting markers to be removed from the analysis.

¢ Marker Simulation platform is used to evaluate potential crosses using information from
parental genetic markers and predictor formulas for traits of interest to breeders. It generates
output of the simulated marker genotypes for all progenies with their respective predicted
trait values across generations. It also provides summary statistics for the predicted trait
values for each cross across generations.

Description

Provides an interactive interface to create flexible trellis displays that are useful for visualizing
multivariate data. Plots can be conditioned on discrete and continuous variables and include dot
plots, smooth curves, normal density ellipses, box plots, lines, bar charts, and histograms. Available
plots include contour plots, maps, parallel plots, mosaic plots, pie charts, treemaps, area charts, heat
maps, formula charts, and line of fit. Map shapes are also supported.

Displays circles according to positional specification. Circles can be sized and colored according to
selected variables. When there is a time variable, selected variables can be viewed dynamically over
time.

Displays scatterplots and density ellipses for all pairs of Y variables, or for a selection of Y variables
plotted against one or more X variables.

Draws a plot that connects the values of selected Y variables for each row in the data table.

Creates a rectangular array of cells drawn with a one-to-one correspondence to data table values,
and colored by the values in the cells.

Creates three-dimensional rotatable plots for multiple Y variables. Displays and saves principal
components, standardized principal components, and rotated components. Also displays normal
contour ellipsoids, nonparametric density contours, and biplot rays.

Constructs contour plots for one or more numeric response variables, Y, across a grid defined by
two numeric X variables.

Illustrates the distribution of three-part (numeric) compositional data, using a two-dimensional
plot.



Graph Menu (Continued)

Item
Surface Plot

Profiler

Contour Profiler

Mixture Profiler

Custom Profiler

Excel Profiler

Legacy

Tools Menu

Item

Arrow

Help

Selection

Scroller

Description
Creates a three-dimensional, rotatable display of points or of a surface defined by a saved formula.

Displays prediction traces for each X variable, based on saved prediction formulas for each numeric
response and linear constraints on the X variables. Allows simultaneous optimization of responses
using desirability functions, estimation of response distributions using the simulator, and accesses
and links to other profilers. Can be saved as an Adobe Flash file (.swf) to display in a web browser.

Displays contours of the prediction formulas for two factors at a time, along with three-dimensional
mesh plots. Accesses the simulator, and links to other profilers.

Displays a ternary plot and contours of the prediction formula for models involving mixture factors.
Accesses the simulator, and links to other profilers.

Provides an interface for simultaneous optimization of responses, similar in function to the profiler.
Allows linear constraints and a user-defined criterion for optimization, and displays predicted
performance relative to benchmarks. Accesses the simulator, and links to other profilers.

Provides a method for transferring Excel data to JMP. You can then analyze the data using JMP
profilers.

Provides access to graphs that you can now create in Graph Builder.

* Treemap creates a rectangular tiling for a nominal or ordinal variable where you can tile
categories to be proportional in size to the counts of categories within a selected variable. A
positional specification is optional.

* Chart plots bar, line, pie, needle, and point charts of user-specified summary statistics for
multiple selected Ys across the values of up to two X variables.

¢ Opverlay Plot plots one or more numeric Y variables across the values of a single X variable;
several plots are constructed in one window using grouping variables.

Description

The default tool.

* Enables you to select points in plots and analysis options. Drag the cursor to select multiple
points.

* Rotates the plot in Surface Plot and Scatterplot 3D.
Opens context-sensitive Help when you click the help tool in any part of a display or report.

Enables you to select rows or regions of rows when you click and drag. Selects portions of graphical
output or analysis results.

Scrolls a report or journal window in any direction with more precision than when using scroll bars.
The scroller is available in report windows and journal windows.
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Tools Menu (Continued)

Item

Grabber

Brush

Lasso

Magnifier

Crosshairs
Ruler
Annotate

Line, Polygon,
and Simple Shape

Description

Changes axis scaling when you hover with grabber and click over an axis. Hand changes
orientation to indicate direction of change.

Changes both axes simultaneously when you click and drag within a plot.

In histograms, changes the number of bars or shifts the boundaries of the bars on the axis when
you click and drag.

In any report table, rearranges columns.

In Surface Plot and Scatterplot 3D, click and drag an axis to move it. When you click the plot, the
grabber turns to an arrow and enables you to rotate the plot.

Enables you to select one or more points when you brush over them.

Enables you to circle points with a curve. Press Shift or Ctrl and circle more points to extend a
selection.

Enables you to zoom in to a plot when you click where the enlarged graph should be centered.
Double-click to restore the graph to its original dimensions.

Displays a moveable set of magnified axes to precisely locate points and estimate distances on plots.

Enables you to drag a ruler on a graph to measure distances.

Enables you to add editable text notes to JMP reports and journals.

Enables you to draw lines, polygons, and shapes on JMP reports and journals. Right-click a line or
shape for a menu of options.

The Project menu appears only when a project is open.

Project Menu

Item

Undo Layout
Redo Layout
Reset Layout

Show Workspace

Show Bookmarks

Show Contents

Show Recent Files
Show Log

Project Settings

Description

Enables you to undo actions performed on the tabs.
Enables you to reverse actions performed on the tabs.
Returns all open reports and data tables to a tabbed view.

Opens or closes the Workspace pane in the project window. This pane shows tables, reports, and
scripts that are open in the project.

Opens or closes the Bookmarks pane in the project window. This pane shows shortcuts to
frequently used files and folders, organized into groups.

Opens or closes the Contents pane in the project window. This pane enables you to view, open,
and modify files in the project contents.

List of recently used files, the same files shown on the Home Window.
Opens or closes the Log in the project window.

Enables you to write a script to automate tasks when the project is opened.
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View Menu

Item

Associated Data

JMP Starter

Home Window

Window List

Log
Recall Last Platform
Status Bars

Thumbnail Panel

Home Window
Panes

Toolbars
Running Queries
Add-Ins...

Customize

Window Menu

Item
New Data View

Reveal

Close All
Applications

Close All Reports
Close All Journals
Close All Scripts

Close All Data
Tables

Close All

Description

Brings the data table for the open report to the front. Available only when the current report
window is connected to a data table.

Opens and closes the JMP Starter window, which gives access to most commands found on the
main menu or on toolbars.

Opens and closes a window that lists recently opened JMP files. Shows open JMP windows in an
outline view (the same list that appears when you select View > Window List). Also enables you to
pin frequently used files.

Opens and closes a window that lists open windows. These windows are shown in an outline
view.

Opens a window that shows information such as JSL statements as they execute and script errors.
Opens the platform launch window that was last opened.
Opens and closes the status bar at the bottom of the JMP window.

Shows or hides the previews of open report windows at the bottom of the data table window.
Available only in data tables when a report window is open.

Enables you to choose which panes to display on the Home Window. Also enables you to revert
your changes to the JMP defaults. Available only from the Home Window.

Enables you to add, remove, or revert to the original toolbars.
Enables you to view ODBC queries that are running against an SQL database.
Lists the add-ins that you installed in JMP.

Enables you to customize the toolbar and menu items and revert to the original settings.

Description
Displays a duplicate view of the active data table that is linked to the original data table.
Shows previews of all open JMP windows so that you can quickly open another window.

Closes all open applications and dashboards. Appears only when the active window is an
application or dashboard.

Closes all open reports. Appears only when the active window is a report.
Closes all open journals. Appears only when the active window is a journal.
Closes all open scripts. Appears only when the active window is the script editor.

Closes all open data tables. Appears only when the active window is a data table.

Closes all open windows.
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Window Menu (Continued)

Item

Minimize All
Restore All

Bring All Forward

Arrange

Combine
Windows...

Move to/from
Project...

Redraw
Font Sizes
Set Title

Move to Back

Hide

Unhide

Help Menu

ltem
JMP Help
Search JMP

JMP
Documentation
Library

Discovering J]MP
New Features

Quick Reference
Card

Menu Card

Sample Data Folder

Description

Minimizes all open windows.
Displays all minimized windows.
Brings all JMP windows to the front.

Shows options for selecting, displaying, and clearing selected windows. After you select
windows, the Arrange Selected Windows option appears, which shows all selected windows
side-by-side. After you select a report, the Arrange With Data Table option appears, which shows
the report next to its data table.

Enables you to select open JMP windows and merge them into a dashboard. Options include
using a report as a selection data filter and displaying in Full or Summary view.

Enables you to move selected windows to or from a new or open project.

Refreshes a window after it shows stray imperfections from high-speed, dynamic handling.
Increases and decreases the size of text in all open windows.
Enables you to change the name of the active JMP window.

Moves the active window behind all other JMP windows and shows the next window in the
sequence.

Suppresses the display of the active window but does not close the window.

Enables you to select the hidden windows that you want to view or unhide all hidden windows.

Description
Opens the latest JMP Help in a web browser.
Search JMP to find statistical tests and other capabilities.

Opens a single, searchable PDF file that contains all JMP books.

Opens a PDF file that will help you get started with JMP.
Opens a PDF file where you can learn about the latest features in JMP.

Opens a PDF file that contains keyboard shortcuts to help you work faster.
Opens a PDF file that contains descriptions of JMP menu options.

Opens a list of JMP sample data to learn about JMP analyses. Open a sample data file and run a
script to see a sample analysis.
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Help Menu (Continued)

ltem Description

JMP on the Web Opens the JMP website, JMP New User Welcome Kit, JMP User Community, Statistical Thinking
Course, and Statistics Knowledge Portal.

Tutorials Opens a set of JMP tutorials to learn about statistical techniques.

Tip of the Day Opens the Tip of the Day window, which provides tips and tricks for using JMP effectively.

Statistics Index Defines statistical terms, opens online Help, launches analysis platforms, and enables you to run

scripts that illustrate the terms.

Scripting Index Defines JSL functions, JSL objects, and display box elements. Several search options are available.
You can also run examples and read online Help for the components. Above the list of commands,
select All Categories to search all functions, objects, and display box elements.

Sample Index Opens the Sample Index window, which provides links to sample files. Many sample data tables
include scripts that you can run to see examples of JMP tools and analyses. You can also run the
sample scripts themselves to see examples of JMP tools and analyses.

Renew License Enables you to select a new license file to renew your JMP license. Available only in annual license
copies during the grace period and before the license expires.

About JMP Shows the product version, registration, user and system information, the JMP web page link, and
more.

The Format menu appears only when an application or dashboard is open.

Format Menu

ltem Description

Add Module Creates a new empty module.

Delete Module Removes the currently displayed module from the application or dashboard.

Align Boxes Lines up the selected objects by the type of alignment that you select from the submenu.
Add Container Places the selected object inside the object that you select from the submenu.

Remove Container =~ Removes the selected object from its container.

JMP and all other JMP Statistical Discovery LLC product or service names are registered trademarks or trademarks of JMP Statistical Discovery LLC in the USA and other countries,
® indicates USA registration. Other brand and product names are trademarks of their respective companies.
Copyright © 2022 JMP Statistical Discovery LLC. All rights reserved.
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